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Table 2.1 The consolidated data of damage tracker
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Table 2.2 The output of the Dashboard (Category wise)

Damage Type Quantity Total Cost
Customer Return Dispose XX XX
Warehouse Damage X Xx
Vendor Damage XX Xx
Expired XX Xx




Table 2.3 The output of the Dashboard (Function wise)

Process Count of damaged items Sum of item cost
Pack XX Xx
Pick Xx Xx
Rebin Xx Xx
Stow Xx Xx
Grand Total Xx Xx

Table 3.1 The summary table of one click depository

Function SI/SOP <2017 2017 2018 2019 2020
1 | Inbound 500 200 110 70 55 43 20
2 | Outbound Xx XX XX XX XX Xx XX
3 ICOA Xx XX XX XX XX Xx XX
4 FC Dock Ax XX XX XX KX XX XX
5 Transshipment | Xx XX XX XX XX XX XX
6 Others Xx XX XX XX XX Xx XX
7 Total Xx XX XX XX XX Xx XX




ABSTRACT

The projects are focused on improving Process within the FC and the Customer
Experience.DEL3 FC is known as Extra-Large Pantry Site in IN, where ~X Million units are
getting received and shipped in a month cycle with ~75% of volume contribute to pantry
products, there are some challenges faced by the damaged products, the aim is to design a
damage tracker that can track the items getting damaged at different stagesand in different
process. Also, in lieu of the current COVID situation there are process improvement required in
Fulfillment center with regard to Social Distancing guideline, so the goal is to design, plan and
execute of plan which will ease Inbound and Outbound Process along with streamlining barriers
faced by FC AA.
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CHAPTER 1

INTRODUCTION

1.1 History and Background

Amazon is an American multinational company, founded by Jeffrey P. Bezos in 1994, a
computer science and electrical engineering graduate from Princeton University. He incorporated
the company as Cadabra in July 1994. He quickly dropped this name when a lawyer he contacted
mistook it for cadaver, then the name Amazon was founded soon after, the Amazon River, which
is the largest river in the world, and the letter “A” to “Z” signifies availability of every product,

with an arrow pointing from a to z, which signifies customer satisfaction as it represents

delivering smiles.

Fig 1.1

The company has improved a lot since last 20 years and is continuously growing.
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The one thing that made them so famous was Books. The Seattle, WA based company has grown
from a book seller to a virtual Wal-Mart of the Web selling products asdiverse as Music CDs,
Cookware, Toys and Games and Tools and what not. The company made its first profit of $5.8

millionin the year 2001.

Bezos was working as the senior Vice-President at D.E Shaw, a Wall Street investment bank,
before he resigned and moved to Seattle. Earlier he did not know much about Internet but soon
he came across a static of Internet growing at 2300%, which convinced him that it was a great
opportunity to grow. Even though not knowing much and no prior knowledge of retailing, he
entered into the world of E- Commerce.He opted to locate the company in Seattle since it had a
large pool of technical talent and also because, it was close to one of the largest book
wholesalers. The company finally went on-line in July 1995, and went public in May 1995.

“I knew that if | failed | wouldn't regret that, but | knew
the one thing | might regret is not trying.”

Fig 1.2

For his contribution, Jeff Bezos at the age of 35 was picked as the 1999 Time person of theyear,
making him the fourth-youngest person of the year. Describing why it chose Bezos, Time

magazine said, “Bezos’ vision of theonline retailing universe was so complete, his Online
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Shopping for Electronics, Apparel, Computers, Books, DVDs & more site so elegant and
appealing that it became from Day One the point of reference for anyone who had anything to

sell online”.

1.2 Leadership Principles

Amazon is a customer centric company it has 14 leadership principles by which it works,

which are mentioned below
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AMAZON'’S 14 LEADERSHIP PRINCIPLES

Customer Obsession
Start with the customer and work
backwards; work vigorously to
earn and keep customer trust; pay
attention to competitors, but keep
obsessing over customers

Learn and Be Curious

You are never done learning and
you always seek to improve; you
are curious about new possibilities
and act to explore them

Bias for Action
Speed matters in business. Many
decisions and actions are
reversible and do not need
extensive study. We value
calculated risk taking.

Have Backbone.
Disagree and Commit

Respectfully challenge decisions
when you disagree, even-when
doing so is uncomfortable or
exhausting; have conviction and
be tenacious; do not compromise
for the sake of social cohesion;
once a decision is determined,

- commit to it.

Ownership
Think like an owner, long term and
don’t sacrifice long-term value for
short-term results; act on behalf of
the entire company, not just for
your own team; never say “that’s
not my job"

Hire and Develop the Best

Raise the performance bar with every hire and
promotion; recognize exceptional talent, and

willingly move them throughout the organization;

develop leaders and take seriously your role in
coaching others

Frugality

Accomplish more with less.
Constraints breed
resourcefulness, self-sufficiency
and invention. There are no extra
points for growing headcount,
budget size or fixed expense.

Deliver Results

Focus on the key inputs for your
business and deliver with the right
quality and in a timely fashion;
despite setbacks, rise to the
occasion and never settle.

Invent and Simplify
Expect and require innovation and
invention from your team and always find
ways to simplify; be externally aware,
always look for new ideas from
everywhere, and don't be limited by “not
invented here"

Think Big

Thinking small is a self-fulfilling prophecy.
Create and communicate a bold direction
that inspires results. Think differently and
look around corners for ways to serve
customers.

Leaders are Right.

A Lot

You have strong judgment
and good instincts; you
seek diverse perspectives
and work to disconfirm
your beliefs

Insist on the Highest Standards

You have relentlessly high standards - many may think
these standards are unreasonably high; you are
continually raising the bar and driving your team to
deliver high quality products, services and processes;
defects do not get sent down the line and problems are
fixed so they stay fixed

Dive Deep

Earn Trust

Operate at all levels, stay connected to
the details, audit frequently, and be
skeptical when metrics and anecdote
differ. No task is beneath you.

Listen attentively, speak
candidly, and treat others
respectfully. Be vocally
self-critical, even when
doing so is awkward or
embarrassing; leaders do
not believe their or their
team’s body odor smells of
perfume; benchmark
yourself and your team
against the best.

P z Watch the full story about this framework on my YouTube channel © Dan Croitor 2017  part of my video series about unique company principles and culture

1.3 Fulfillment Centre

The great example of operating model in action of Amazon is the Amazon’s Fulfillment Centre.
The process for distribution of man power requires the use of many seasonal workers during the
seasonal peaks to ensure customer promises are met and that packages are shipped as soon as
possible during peak shipping times. When the orders are placed by a customer then the assigned
picker receives the order on the scanner and is informed of the location for each item. The
scanner is linked to a computer system that figures out the fastest route or gives the batches
depending upon the most convenient and faster picks within the warehouse to pick up all the
items. If the items are evenly distribute throughout the warehouse, it allows a worker to find

them faster. Once the items are found, they are placed in yellow containers that travel on

Fig 1.3

conveyor belts that will eventually lead to the packing area.

The packing area is aided by system that determine the optimal box, packing material, and length
of tape to use.The packed items are then placed on conveyor belts where according to the

shipmentsthe batches are segregated and the sent for packing; after which the shipment label is
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pasted and then are sent to delivery trucks. In the delivery trucks, the shipments are placed

according to the area they are

supoosed to reach.. Items are then shipped out to sort centres and

then to delivery stations from where they are delivered to the customer.

1.3.1Inbound

Inbound

Outbound

FC Dock

Departments
|

- ICQA

The three main process flow in inbound include-
- IB Dock

- Receive

- Stow

ASIN - Amazon Standard Identification Number.

Types of ASIN-

a) 1B Dock:

XOO label - It starts with X00. Used in the transshipment products
that are sent from one FC to another FC.

BOO label - Each item has a registered BOO label with Amazon.
ISBN - International Standard Book Number

EAN - European Article Number

UPC - Universal Product Code.

LPN - This stands for License plate number. This is used for

customer returns.



The pre check-in of the vehicle is done through the YMS.
YMS is a portal used to check which dock is free and assigning dock according

to the appointment scheduled and availability of dock.

b) Receive:

The unloaded items are received at different stations

Types:
- Each receive - No prep activity is performed on the ASIN. Items like shoes

and HRV.
- Prep receive - PrepActivity is performed on the ASIN as per requirement
and the demand.

- Pallet receive - Entire pallet is received. In this large amount of same item
is received together after doing shrink wrap on it. Pallets should contain
the same ASIN for pallet receive. For this a label known as PaX label is

pasted after the pallet is received.

- Case receive - Case receive is the receiving of an entire carton at a time. It

must also have a single ASIN. The CsX label is used for this receive.

c) Stow:

1TP- Inbound Tracking Portal. It is a portal shows all the totes,carts that have
been received but yet not been stowed. In this portal those carts are
shown whose dwell time is less than 6 hours. After receiving within
2-3 hours stowing must be done.
o Cart dwell time if < 8 hours-green

o Cart dwell if > 8hours-light pink
6



o Cart dwell time if > 24 hours- dark pink

IOL- Inventory Odd Location. Carts with dwell time more than 12 hours

get transferred from ITP to IOL.

FUD - Fulfillable Unfilled Demand. The items not in prime but in

reserved which need to be stowed. This shows prioritization of carts

that need to be stowed. It has the highest importance among I0L &
ITP.

There are 2 criteria for FUD-

i. By NBD — Need Buy Date.
Red - Carts to be stowed in 30 minutes.
Pink - Carts to be stowed in 30 minutes — 4 hours.
Orange - Carts to be stowed in 4 — 24 hours.
Yellow - Carts to be stowed in 24 — 48 hours.
Green- Carts to be stowed in 48 — 72 hours

Blue - Carts to be stowed in more than 72 hours.

FUD Reports

FUD By NBD

00 6 3 5

FUD By Dwell Time™

[ 12

Export o CSV




Fig 1.4

ii. By Dwell time —
Red - Dwell time greater than 24 hours.
Orange — Dwell time between 6 - 24 hours.
Yellow - Dwell time between 1 - 6 hours.

Green - Dwell time is 1 hour.

1.3.20utbound —

In outbound, the items on which customer orders are placed are processed.

The various function in outbound are-

- Pick

- Wrangle
- Rebin

- Pack

- SLAM

1.3.30rders vs Shipment

When a customer orders one or more items directly from Amazon.com, an order is
created in the system to track it. This order will be passed to the planning system, which
calls multiple other services to determine the cheapest way Amazon can deliver the order

within a given promised timeframe.

1.3.40rder assignment

When a shipment is created, inventory items in the warehouse are reserved for the order.

This process is called order assignment.



System reserves inventory by associating the virtual order items to physical inventory
items in specific bins. A portal ‘X’ tries to optimize inventory selection and find
shipment items in locations near to one another, but it hasn't created batches yet so it can't

ensure that units in a batch will be located together.
Assigning a Shipment ship date:

Ship date determines due dates in the FC and represents the last chance to ship the order
to meet customer. Ship Date is used to determine units should be picked, and when to

start chasing units that are getting late

- An order can be group of items ordered by a customer, whereas shipment can be
understood as the package sent to a customer. An order can have multiple

shipment, but a shipment can’t have multiple order.

1.3.5Process Paths:

Process paths describe how orders are to be picked, sorted, packed, and shipped. The
portal ‘X’ assigns different process paths for different types of orders, then tracks orders
through the FC based on the process path.

Singles directly pack after picking, while Multis are sorted Customer wise before
packing.

1.3.61COA -



Bin Counting

SBC CcC SRC

- SBC: In this type of bin counting each item in the bin is counted. And if
there is any mismatch between the physical counting and virtual quantity,

it is moved to CC, hence these two are related.

False Adhoc - When less/more items counted in SBC and in CC scanned

more/less then false adhoc occurs.

- CC: In this ASIN wise counting is done and each item in the bin is

scanned.

- SRC: In this the scanner asks to scan a particular ASIN in a bin.

1.4Project(s) Executive Summary:

The key deliverables of the projectsare on improving the ease of access to the SJIs and SOPs,
tracking the FC damages with the help of an Automated Damage Tracker and a strategic plan
for deployment of stowers and pickers to follow Social Distancing along with the process

flow.

Key themes of the project are as follows:
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b)

a) One click depository where expectation is to design an excel sheet of all the
standard SJIs and SOPs which would help ACES team to revise standard
according to new update.

b) An Automated Damage Tracker in which the expectation is to make a dashboard
that would help Analyst Team to Study Damage Analysis for any consecutive day
with 1 click button.

c) To optimally deploy stowers and pickers in a way that would help DEL3 team
with pick and stow mechanisms without causing a hindrance to the social

distancing norms.

One click depository

The SJIs and SOPs on SharePoint lack a tracking mechanism because of
unconsolidated data. This has led to absence of revision of some SOPs since 2015.
The current depository would help in tracking the same and refreshing the content.

Project Status: Completed

Automated Damage Tracker

Initial Plan is to design a dashboard- An Automated damage tracker which would
reduce the requirement of manual search and make it easier to do the damage data
analysis of a particular day/month/year.

Project Status- Completed

Optimum deployment of Stowers and Pickers to follow Social Distancing

In this present situation of COVID-19, the main focus area is the social distancing so

as to maintain a distance of 2m/6t.

11



According to the present guidelines the maximum picker/stower that can be deployed
in an aisle are 2, so the plan of this project is to analyze the inventory and optimally
deploy outbound pickers/inbound stowers in an inventory floor without causing a
hindrance to social distancing norm of 2m/6t.

Project Status- WIP
ETA- Wk24

1.5Tools Used:

- Macro

- VBA

- MS Excel

- SQL query to generate data

- Amazon Portals to fetch data and perform data analysis

12



CHAPTER -2

THE AUTOMATED DAMAGE TRACKER

2.1Background

The Automated damage tracker is a dashboard that would help the FC to track the category-wise
daily damage generation with just a single refresh. It will always help to categorize the damages
that happen during different process in different functions, in accordance to the quantity as well
as cost, which would help to take necessary actions where in particular it is contributing to more
loss so that it can be controlled. It will also give the data of the top items that are getting
damaged and the high alert areas, so that the root cause can be determined by deep dive and a

solution could be found to control it. It will help the FC to control damages and prevent losses.

2.2Approach Note

Approach on key deliverable are with regard to Plan/Design and Execution details mentioned

below:

Plan:

13



- Got acquainted with the present scenario of the FC by extracting data from different
portals and web queries for analyzingthe data for damages and seeing the trend that is
going on, so that the root cause can be found out.

- Analyzed the key metrics related to the data, what process is being followed, various

touchpoints that the item passes through and the damaged data from the portal ‘X’.

Design: A dashboard for damage tracker using macros.

2.3Macros Basics

Excel Macros helps to save time on repetitive tasks which are involved in data manipulation and
data reports that are required to be done frequently, which saves a lot of time and makes it user
friendly. We can record a macro by doing the tasks that we want the macro to perform every
time we give input to the macro and it performs repetitively the same task again and give us the
desired output. In the background when we record a macro it stores it in the form a VBA code,
but it is not preferable because the code is longer and takes unnecessary time, also the
unnecessary codes are also recorded which make the macro heavy, so it is always preferable to
use VBA and write the code manually to make the dashboard faster and more efficient. When the

macro is recorded, the code can be viewed on the VBA editor.

2.4VBA-

VBA stand for Visual Basics for Application.VBA allows to automate various activities in Excel
like, preparing charts &graphs, doingcalculations,generating reports etc. This automation activity
in excel is referred to as Macro. This way it helps the users to save their time spent behind
performing the same/repetitive steps again and again.It is basically used in Microsoft Excel to
create sophisticated and one time activity tools that can be used in various sectors like
engineering, business and science. VBA allows users a different level of customization beyond

what is typically available in Microsoft Office products, such as MS Excel, MS Word or Power
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Point. A user types commands into an editing module to create a macro. Macros then allows the
user to automatically generate customized reports, pivot, charts and perform other data
processing functions depending upon what the user wants the VBA to perform. Withindifferent
industries, VBA for Excel is commonly used to develop and maintain complex spreadsheet
models. Using VBA, a rapid design and analysis tools for engineering can be easily constructed
in office applications.So in short, VBA is a great all-in-one kit for customizing the Office

experience and making it better.

In VBA, the data from we, query or link can be directly fetched and the various operations can

be performed on them accordingly.

2.4.1 Advantages of VBA -

» The structure of the Basic programming language is very basic and simple, in
particular with regards to the executable code.

» The VBA-IDE has been highly optimized to support rapid application development
(“RAD”). It is particularly easy to develop graphical user interfaces (GUI) and to
connect them to handle functions that are provided by the application.

» VBA is not only a language but also primarily an integrated, that is an interactive
development environment (“IDE®).

» The graphical user interface of the VBA-IDE provides highly appealing views for
the management of the program structure in the large and the various types of
entities like the classes, modules, forms, etc.

» VBA provides an interactive, comprehensive and context-sensitive online help
system.

» When editing program texts, the “IntelliSense” technology informs you in a little
popup window about what are the types of constructs that may be entered at the
current cursor location.

» VBA is a component integration language which is accustomed to Microsoft’s COM
(Component Object Model).

» Component Object Model components can be written in different languages and also

then can be integrated using VBA.
15



» Component Object Model components can be linked to or embedded in the

application’s user interface and also to/in stored documents.

2.4.2 How to Access VBA

To get started with VBA, it first needs to be ensured that the various buttons and functions are
active or visible that build the macro.

Those are all found within the Excel’s “Developer” tab. However, by default, the Excel hides
this tab, so it is not visible and it needs to be made visible. To have it as a part on the toolbar

some steps need to be taken.

To enable the “Developer” tab—

In PC:
> Visit the “File” menu
> Select the “Option.”
» Click “Customize Ribbon” within the menu
» Check the box for the “Developer” tab.

» Click “OK” and the “Developer” tab will appear in your ribbon.
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Fig 2.2
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2.5Data Analysis/ Research

The data (Refer Table 2.1) is analyzed from a Portal, in which there are different application
name. If the damaged data goes to the dmgExp001, it is then damage that occurred due to the
expired items which goes to the virtual container dmgExp001. Similarly, if it falls in the
dmgIBVENOO1, it is the vendor damage, tsCret is the damage due to items that were
customer return and tsHazmatdis002 is the virtual container for the damaged hazmat items.
Like the expired items that were marked damaged and moved to virtual container
dmgEXP001 were 2 beauty products and 180 grocery items as shown in the below data. This
is how the macro will fetch data and segregate it on the basis of department, zone, function

process, type of damage and the type of product etc.

2.60utcome

For any FC, it is needed to keep a track and analyze the damaged data, so that changes can be
made done accordingly to reduce it. For damage analysis, it is needed to go through various
portals or generate a query to extract the data which is generally time-consuming. Thus a
dashboard will help the FC team Research Analyst in the department of ICQA to study the
damage analysis for any consecutive day with one-click button. Also the concerned
departments themselves can check their data and see where there are going wrong so that the
touchpoint can be detected and accordingly the necessary actions can be taken to prevent any

kind of loss and also give a better customer experience.

2.6.1 Output of the Dashboard

For the output as shown on the dashboard (Refer table 2.2 and 2.3)
For the VBA Code of the Macro (Refer APPENDIX A)
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CHAPTER -3

ONE CLICK DEPOSITORY FOR SJIS/SOPS

3.1Background

Amazon has a standard of process for every department/process/function. It is followed in every
process and if there are any changes with regard to it, they are made in the SJI/SOPs available on
the SharePoint folder. The problem is that that the SharePoint has many folders and sub folders
of the department and the process, which makes it time — consuming to go through each and

every folder/ subfolder and search for the one that is required. There is a team of ACES that
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keeps on updating it. There are many SJIs/SOPs that have not been updated since 2015and needs
to be updated, so the expectation of this project was to consolidate them into an excel file
department wise and process wise and segregate it according to the year in which they were last
updated, by which ACES and the version that it holds in a one — click depository so that it can be
moved forward to the central ACES team and the changes can be done accordingly. It also

makes it easier for anyone who want to go through the SJI/SOP without the need of searching it.

Version (Changs Date _Year Change Description

100 [zen o |l gaints were verified and uatdted in new format including exceptions alon
08 [1y70 (a0 Al gaints were verified and updated in new format including exceptions alon
105 018 Updated based or . rocess

102 018 [l points were verized and uadated in new format incuding exceptions alon
103 018 Al points were verified and updated in new format incuding exceptions alon
105 018 Al points were verified and updated in new format incuding exceptions alon

Safety raquirement

Point No. A Addd, having valid TDR badge

2 1172019 2019 Poirtt No. C : Addzd, Use both hand

Point No. H : use mechanical lift for heavy cartons (> 45 Kgs)
Point No. | 48" changed to 6 fest

WA 2019 Al points were verified and updated in new format including exceptions alon
102 2019 [All points were verified and updated in new format including exceptions alon
i 111 2019 Al paints were verified and updated in new format including exceptions alon
i 105 2019 Al paints were verified and updated in new format including exceptions alon
: w04 5o Jaon Wik link or Freight refusal guidelines for Heavy Bulky added under Dbjective
I 104 23/042019  |NA Addition of point for shipment level reconciliation
E NA NA NA NA
b NA NA NA NA
NA NA NA NA
101 31/01/19 2019 Initial version
101 25/03/2020 2020 New document
102 6/2/2020 2020 General guidelines and defects to be checked during samgle check are addec
108 [13j072010 [o018 s e veriied and updted in new format including exceptions alon
111 28/08/2019 2019 ‘ool added to annexure

anveu runn 1 tightening the seal of aroduct while performing preg in SOP F

112 21/01/2020 2020

cap sealing and how to perform cap sealing.

3.2 Approach Note

Approach on key deliverable are with regard to Plan/Design and Execution details mentioned

below:
Plan:The tenet was fixed to ease the access of SJIs/SOPs change the old version documents.

Went through each SJI and SOP to summarize all those require revision. Made and excel file of

what all keys would be required and what all needs to be eliminated.
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Design: One-click SJI/SOP portal with separate paths for each function and sub-function
(Process Paths), which enlists Title, Version , Last SOP Revision, Owner of SOP, Change

description.

Execution:
- An Email Communication was shared with the whole team.
- Central ACES will be working on changing old document versions with the help of site

managers.

3.3 Data Analysis
On doing data analysis the updated SOP/SJI versions on the basis of year could be deduced, like
in Inbound suppose out of 500 SJIs/SOPs

- 200 were updated before the year 2017,
- 110 were updated in 2017

- 70 were updated in 2018

- 57 were updated in 2017

- 43 were updated in 2020

- 20 had no information

And so on for the other departments as well...

And the output will be displayed as (Refer Table 3.1)

3.4 Outcome
Email communication rolled out on completion of one click depository for SOP/SJI for further
actions to be taken.
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Chaturvedi, Nupur

[COMMUNICATION] : SJI/SOP One Click Depository
To Dhingra, Madhav; ‘del3-site-mars@amazon.com'

Ce Garg, Rajat; Kaura, Anuj; Thanvi, Narottam

0 days)

Retention A

30 Day Sent |

© this item wil expire in 24 days, To keep this item longer apply  different Retention Policy.

SOP_S/| One Click Depositoryxisx _
63 KB

What s this mall about?

Why was the change reqired?

xpires

] hred e wme S0Py snce 2015,

What s the Proposal?
The brief description of the Depostory s ¥ bekow

o Mnkats Titke, Version, Last S0P Revésion, Ouner of $09, Change deicriotion

What i the summary of the current SA revighons!

Inbourd 7
Outbouns
[
£ Dock

Transshoment
Others [l
* STNgar Istructon with 10 VETsice Declfew.

T

Fig 3.1
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CHAPTER-4

OPTIMUM DEPLOYMENT OF STOWERS

AND
PICKERS TO MAINTAIN SOCIAL DISTANCING

4.1 Background

In the interest of the health and safety of all Amazon Associates, Leadership teams and Support teams, the
need has become apparent for a Portable Social Distancing Barrier Assembly. This will enable Operations
tier 3, Leadership, Learning and/ or HR to deliver feedback and other information directly to Amazon
Associates when the need arises. In order to facilitate part of this effort, this project requires to construct a
social distancing barrier. This barrier—referred to as Portable Social Distancing Barrier—will allow
everyone in the premises to maintain social distancing of 6ft/2m, while offering an engineering control to
achieve our social distancing goals. It requires to give a mathematical modal according to the
infrastructure of the building that at a time how many stowers that are stowing in the inventory and how
many pickers that are doing picking can be accommodated in an aisle at a time so that the asked distance

is maintained and the norms are not breached.

During the ongoing operations within FC, wherein as of now 2 people, be it stowers or pickers are
permitted within an aisle with a considerable distance of 6ft/2m.This has even led to decrease in rates and
productivity. So it requires to analyze the inbound and outbound flow and bring the necessary changes in
the deployment that would help to collectively tackle the problem and give an accurate data for the

deployment to solve the current problem faced do to covid-19.
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4.2 Research/Data Analysis

Analyze the inventory placement layout and pick path. From the research, on the basis of
calculations it was found that the maximum stowers and pickers that can be deployed in an aisle
is 7, against the current given number of 2. And also considering that the stowers/pickers don’t
cross each other, the aisles have been made one way, such that the exit and entry is only from the

alternate aisles and prevents crossing of people.

*This is an ongoing project and the data is confidential which can’t be revealed*

24



APPENDIX A

Sub DWP_Pivot()

TA Cells Clear
DA Range("Al").CurrentRegion. Copy TA Range("Al1")
Application CutCopyMode = False

Formulae

Dim LRow As Long Last Row
LRow = TA Cells(Rows.count, 1).End(xIUp).Row

With TA
Formula 1
Range("L1") Value = "MOD"
Range("L2") Formula = _
"=[F{OR(SF2=""dmg400"" $F2=""dmg401""), $F2 IF(OR($K2=""Pick"" $K2=""Stow"")
RIGHT(SF2.4), ""Container""))"
Range("L2") AutoFill Destination:=TA Range("L2:L" & LRow)
Formula 2
Range("M1"). Value = "MOD1"
Range("M2"). Formula = _

"=IF(OR($F2=""dmg400"" SF2=""dmg401"™),""PIT"" IF(MID($F2.4.3)=""P3F"" ""P3F"" $L2))

Range("M2") AutoFill Destination:=TA Range("M2:M" & LRow)

Formula 3
Range("N1") Value = "FLOOR"
Range("N2") Formula=
"=[F{OR(SK2=""Pick"" $K2=""Stow"") MID(5F2.7 2),""Rebin+Pack"")"
Range("N2") AutoFill Destination:=TA Range("WN2:N" & LRow)

End With

'Formula 4
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Dim C1 As Range
Dim 1 Az Integer
1=1
For Ezch C1 In TA Range("MI:M" & LEow)
If C1.Value ="PIT" Or C1.Value = "P3F" Then
TA Cellz(i, 14) Value = C1 Value
Elzelf TA Cells(y, 14). Value = "8P" Or TA Cell=(1, 14) Value = "AP" Then
TA Cella(i, 14) Value = "Others"
End If
1=1+1
Next C1

TA ListObjects Add(xl8rcRange, TA Range("$A$1") CurrentRegion, xIVes) Name = "catg”

Yvot Formation]

PA Cells Clear

ActiveWorkbook PrvotCaches Create{ SourceType:=x1Database, SourceData=
"Table DWPlcatG", Version:=6) CreatePivotTable TableDestination= _
"Prvot DWPIRACL", TableName:="cat damage", DefaultVersion:=6

With PA PrvotTables("cat damage”) PivotFields(" bucket")
Onentation = xIRowField
Pozthion=1

End With

PA PrvotTables("cat damage”) AddDataField PA PivotTables{
"cat_damape") PivotFields{"MOD"), "Count of MOD", xlCount

PA PrvotTables("cat damage”) AddDataField PA PivotTables{
"cat damage") PivotFields("item cost"), "Sum of tem cost”, x15um
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PA Range("C5:C9") NumberFormat = "0"

Pivot Formation?

ActiveWorkbook PivotCaches Create(SourceType:=xlDatabase, SourceData=
"Table DWP!lcatg", Version=6) CreatePivotTable TableDestination'= _
"Pivot DWP!R4C5", TableName:="floor damage", DefaultVersion:=6

With PA PivotTables("floor damage") PivotFields("FLOOR")
Orientation = x1IRowField
Position=1

End With

With PA PivotTables("floor_damage") PivotFields{"MOD")
Ornentation = xlRowField
Position =2

End With

PA PivotTables("floor damage") AddDataField PA PivotTables(
"floor _damage") PivotFields("Quantity™), "Count of Quantity”, x1Count

Pivot Formation 3

ActiveWorkbook PivotCaches. Create(SourceType:=xlDatabasze, SourceData:= _
"Table DWPIcatg". Version:=§).CreatePivotTable TableDestination'=
"Pivot DWP!R4CR", TableName:="asin damage", DefaultVersion:=6

With PA PivotTables("asin_damage") PivotFields("item name")
Orientation = xlRowField
Position =1

End With
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PA PrvotTables("asin damage") AddDataField PA PrvotTables(
"azm damage”) PrvotFields("item cost™), "Sum of item cost”, xlSum

PA PrvotTables("asin damage") PivotFields("item name") PivotFilters.
Add2 Type=xlTopCount, DataField=PA PivotTables("asin damage").
PivotFields("Sum of Quantity™), Valuel=10

PA Range{"J1:J207) NumberF ormat = "0"

Dim PT A= PrvotTable

Set PT = PA PivotTables("cat_damage")
PT PrvotCache Fefresh

Set PT = PA PrvotTables( floor damage”)
PT PivotCache Fefresh

Set PT =PA PrvotTables("asin damage")
PT PivotCache Refresh|

Vistbility
TA Visible = Falze
BA Vizihle =Falze
Tnblock the above comment after Dazhboard finalization

End Sub
Sub Fefresh Cache()

Dim PT As PrvotTable
Set PT =PA PivotTables("cat damage")

PT PivotCache Fefresh
Set PT = PA PrvotTables( floor damage”)
PT PivotCache Fefresh
Set PT =PA PrvotTables("asin damage")
PT PivotCache Fefresh

End Sub
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